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Preface

Thank you for purchasing this Sokkia product. The materials available in this Manual (the “"Manual”) have been
prepared by Topcon Positioning Systems, Inc. ("TPS”) for owners of Sokkia products, and are designed to assist
owners with the use of the receiver and its use is subject to these terms and conditions (the “Terms and
Conditions”).

@ Please read the terms and conditions carefully.

Terms and Conditions

Preface

Use

This product is designed to be used by a professional. The user should have a good knowledge of the safe use of
the product and implement the types of safety procedures recommended by the local government protection
agency for both private use and commercial job sites.

Copyrights

All information contained in this Manual is the intellectual property of, and copyrighted material of TPS. All rights
are reserved. Do not use, access, copy, store, display, create derivative works of, sell, modify, publish, distribute,
or allow any third party access to, any graphics, content, information or data in this Manual without TPS’ express
written consent and may only use such information for the care and operation of the receiver. The information
and data in this Manual are a valuable asset of TPS and are developed by the expenditure of considerable work,
time and money, and are the result of original selection, coordination and arrangement by TPS.

Trademarks

MAGNET®, Sokkia®, and Topcon® are trademarks or registered trademarks of the Topcon group of companies.

Windows® is a registered trademark of Microsoft Corporation. The Bluetooth® word mark and logos are owned
by Bluetooth SIG, Inc. and any use of such marks by Topcon Positioning Systems, Inc. is used under license. Other
product and company names mentioned herein may be trademarks of their respective owners.

Disclaimer of Warranty

EXCEPT FOR ANY WARRANTIES IN AN APPENDIX OR A WARRANTY CARD ACCOMPANYING THE PRODUCT, THIS
MANUAL AND THE RECEIVER ARE PROVIDED “AS-IS.” THERE ARE NO OTHER WARRANTIES. TPS DISCLAIMS ANY
IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR USE OR PURPOSE. TPS AND ITS
DISTRIBUTORS SHALL NOT BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS OR OMISSIONS CONTAINED
HEREIN; NOR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE FURNISHING,
PERFORMANCE OR USE OF THIS MATERIAL OR THE RECEIVER. SUCH DISCLAIMED DAMAGES INCLUDE BUT ARE
NOT LIMITED TO LOSS OF TIME, LOSS OR DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR REVENUE,
OR LOSS OF THE PRODUCT'S USE. IN ADDITION TPS IS NOT RESPONSIBLE OR LIABLE FOR DAMAGES OR COSTS
INCURRED IN CONNECTION WITH OBTAINING SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY OTHERS,
INCONVENIENCE, OR ANY OTHER COSTS. IN ANY EVENT, TPS SHALL HAVE NO LIABILITY FOR DAMAGES OR
OTHERWISE TO YOU OR ANY OTHER PERSON OR ENTITY IN EXCESS OF THE PURCHASE PRICE FOR THE
RECEIVER.

P/N: 1005278-01 iv



Preface

License Agreement

Use of any computer programs or software supplied by TPS/Sokkia or downloaded from a Sokkia website
(the “Software”) in connection with the receiver constitutes acceptance of these Terms and Conditions in this
Manual and an agreement to abide by these Terms and Conditions. The user is granted a personal, non-
exclusive, non-transferable license to use such Software under the terms stated herein and in any case only with
a single receiver or single computer. You may not assign or transfer the Software or this license without the
express written consent of TPS. This license is effective until terminated. You may terminate the license at any
time by destroying the Software and Manual. TPS may terminate the license if you fail to comply with any of
the Terms or Conditions. You agree to destroy the Software and manual upon termination of the use of the
receiver. All ownership, copyright and other intellectual property rights in and to the Software belong to TPS. If
these license terms are not acceptable, return any unused software and manual.

Confidentiality

This Manual, its contents and the Software (collectively, the “Confidential Information”) are the confidential and
proprietary information of TPS. You agree to treat TPS' Confidential Information with a degree of care no less
stringent that the degree of care you would use in safeguarding your own most valuable trade secrets. Nothing
in this paragraph shall restrict you from disclosing Confidential Information to your employees as may be
necessary or appropriate to operate or care for the receiver. Such employees must also keep the Confidentiality
Information confidential. In the event you become legally compelled to disclose any of the Confidential
Information, you shall give TPS immediate notice so that it may seek a protective order or other appropriate
remedy.

Website; Other Statements

No statement contained at the TPS and Sokkia websites (or any other website) or in any other advertisements
or TPS literature or made by an employee or independent contractor of TPS madifies these Terms and Conditions
(including the Software license, warranty and limitation of liability).

Safety
Improper use of the receiver can lead to injury to persons or property and/or malfunction of the product. The

receiver should only be repaired by authorized TPS warranty service centers. Users should review and heed the
safety warnings in an Appendix.

Miscellaneous

The above Terms and Conditions may be amended, modified, superseded, or canceled, at any time by TPS. The
above Terms and Conditions will be governed by, and construed in accordance with, the laws of the State of
California, without reference to conflict of laws.

P/N: 1005278-01




Manual Conventions

This manual uses the following conventions:

Convention Description Example

Bold Menu, or drop-down menu selection File » Exit (Click the File menu and click
Exit)

Bold Name of a dialog box or screen From the Connection screen...

Bold Button or key commands Click Finish.

Mono User supplied text or variable Type guest, and click Enter.

Ttalic Reference to another manual or help document | Refer to the Sokkia Reference Manual.

@@S
@
\ 4

Preface

Further information to note about system configuration, maintenance, or setup.

Supplementary information that can have an adverse affect on system operation, system
performance, data integrity, measurements, or personal safety.

Notification that an action has the potential to result in system damage, loss of data, loss of
warranty, or personal injury.

P/N: 1005278-01
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Introduction

Sokkia’s GSX2 receiver is a compact, lightweight, and completely integrated GNSS receiver for static and
cable-free stop and go/kinematic applications. The integrated receiver design includes a GNSS receiver board,
based on industry-leading technology, internal long-life batteries, memory storage, and Long-Range Bluetooth
communication technology. The GSX2 delivers world-class positioning and navigation capability to your
application by tracking signals from multi-constellation satellite systems, including GPS, GLONASS, and SBAS.

The GCX2 includes Sokkia’s exclusive Long-Range Bluetooth Technology®, which provides the perfect solution for
short range job sites that require RTK communication. The GCX2 can be paired with a cellular-enabled data
collector to receive corrections from an NTRIP Caster for rover operation. This setup can also be used with
MAGNET Relay for a cost effective RTK base solution over long distances. The MAGNET Relay configuration
enables you to operate up to ten GCX2 rovers with a single GCX2 base.

The GCX2 offers complete IP67 protection against dust and water ingress, in addition to superior vibration and
shock resistance. The Sokkia communication interface enables you to quickly integrate Sokkia’s premium GNSS
performance within new systems and quickly deliver world-class positioning and navigation support to your
applications.

Figure 1: GCX2 Receiver

Introduction P/N: 1005278-01 1



GCX2 Features

The GCX2 receiver’s advanced design eliminates the need for cables during operation, allowing for a simplified
setup and less parts to keep track of. The GCX2 receiver features the following:

¢ Compact, lightweight, and rugged design

* A premier multi-constellation GNSS board featuring industry leading technology

¢ Integrated multi-channel Long-Range Bluetooth technology

¢ Internal memory for data storage

* One internal battery, providing all day operation under normal operating conditions

* A highly visible display panel with single-button operation

* One USB port for communications and power
You can configure the GCX2 receiver in a variety of ways, depending on your project requirements. Typically,
the receiver supports the following operation modes.

* Static/post-processing data collection

* Job site RTK using Long-Range Bluetooth technology

* Network Rover for DGPS and RTK operation

* MAGNET Relay operation

* SBAS-enabled operation

Unpacking Your Receiver Kit

This section describes the documentation, standard kit components, and accessories (depending on your

purchase) that accompany your receiver. When you unpack your receiver kit, verify you received the items listed
in this section. Make sure the items do not appear damaged from shipment. If any of the items are missing or
damaged, contact your Sokkia dealer or Sokkia technical support. See “Getting Technical Support” on page 3.

® Receiver components are shown in Figure 2.
* Receiver documentation is listed in “Technical Documents” on page 3.

System Components

The items shown in Figure 2 are shipped with your receiver.

o —
' |
SOKKIA i
=
L1 -
Adapter Wall —
Power Charger Folding Clip Kit GCX2 Receiver USE Cable GCXZ LED Card

Figure 2: System Components

Utility software for the GCX2 receiver may be downloaded from the Sokkia support website:

<//>‘ i http://www.sokkiasupport.com/.

GCX2 Features P/N: 1005278-01
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Technical Documents

The GCX2 Operator’s Manual is designed to help you set up and use your new receiver quickly and efficiently.
You can download a digital copy of the GCX2 Operator’s Manual from the Sokkia support website:
http://www.sokkiasupport.com
*  GCX2 Operator’s Manual— An on-screen help document that contains detailed information on how to use your
new receiver.

* Sokkia Receiver Ultility (SRU) Reference Guide — An on-screen help document that contains detailed
information on how to use the SRU software. See “Using Sokkia Software With Your Receiver”.

* GCX2 LED Card - Included in the package, describes the functions of the LEDs.
Using Sokkia Software With Your Receiver
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Use the GCX2 receiver in conjunction with the Sokkia Receiver Utility (SRU) and MAGNET Field™ applications
for a cable-free positioning solution. Using Sokkia software, you can configure the receiver and other external
devices, manage files, collect data, and perform survey and construction work flows.

The Sokkia Receiver Utility (SRU) is a hardware configuration software utility for receivers and peripheral
devices. You can install it on desktop computers and data controllers. You can download the SRU software and
manual from the Sokkia support website: http://www.sokkiasupport.com.

SRU Help is also embedded in the software.

Sokkia's MAGNET® Field software for data controllers provides real-time communication, cloud storage, data
collection and exchange, and field solutions, such as topo, staking, roads, calculations, and more.

MAGNET® Relay is a GNSS correction service hosted by the MAGNET® Solution. With a subscription to MAGNET
Relay, you can connect the GCX2 Cellular receiver to the Relay service (via cellular-enabled data collector) and
use it as a Base for up to 10 Rovers.

Contact your Sokkia dealer for more information about the Sokkia software described above.

Getting Technical Support

Before contacting a Sokkia customer representative about any problems with the receiver, see
“Troubleshooting” on page 26.

For technical support, contact your local Sokkia dealer or visit http://www.sokkiasupport.com.
When contacting Sokkia for technical assistance, provide the following information for better and faster service.

1. A description of the following:
a. Field operation that was being performed when the problem occurred.

b. Details of the unexpected behavior, symptoms, and any error messages that precede or follow the
problem.
c. Problem occurrence frequency or patterns

2. Receiver information and configuration settings. For receiver information, click Information in SRU,
select Save to File, enter a file name, and save it to the computer.

3. Specifications of mobile devices and computers used in the field or office exhibiting the problem. These
specifications should include model information, version number, operating system information, memory
and storage capacity, etc.

4. Information about the system software, including the version number and steps to reproduce the problem.

5. A description of the field environment and/or observation conditions when the problem occurred.

Website

The Sokkia website provides current information about Sokkia’s line of products. The support area of the
website provides access to Sokkia field and office software, manuals, frequently asked questions, and so forth.
To access the Sokkia website, visit www.sokkia.com.

Technical Documents P/N: 1005278-01 3
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Getting Acquainted

The GCX2 receiver enclosure is fully sealed and incorporates the GNSS receiver board, Precision Orbital satelite
tracking technology antenna, battery, memory storage, and Sokkia’s Long-Range Bluetooth Technology®.

Receiver Overview

The GCX2 receiver enclosure is fully sealed and incorporates the GNSS receiver board, innovative POST™
(Precision Orbital Satellite Technology) antenna element, integrated battery, internal memory storage, and
Sokkia’s Long-Range Bluetooth Technology®.

The upper portion of the receiver contains GNSS and antennas for Long-Range Bluetooth communication enclosed
by the radome.

An easy-to-operate display panel, mounting socket, and labels with receiver information are located on the bottom
of the receiver’s aluminum alloy lower enclosure.

The GCX2 receiver has a highly-visible display panel with single-button operation. The display panel enables you
to view the receiver’s operational status. See “Display Panel Operations” on page 19.

The mounting socket (Figure 4) connects the receiver to either a standard 5/8"-11 thread pole or adapter.

Locate regulatory and product identification information on the two receiver labels. The product identification label
contains the serial number and part number along with a quick response (QR) matrix code.

Scan the QR code with any QR code application on a smart phone for product information or visit the Sokkia
support website: http://sokkiasupport.com

Getting Acquainted P/N: 1005278-01 4
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GCX2 Receiver Overview

pajutenboy Sunjan
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Figure 3: GCX2 Receiver Overview

Cable and Adapters

The GCX2 package includes a USB cable for power and data transfer. Table 1 describes the cable and adapters
included with your receiver.
Table 1. Receiver Cable and Adapters

Descriptions Illustration

Mini USB 2.0 Cable
P/N: 14-008081-01

Connects the receiver to an external device
(controller or computer) for data transfer,
receiver configuration, and to a power
adapter for charging the internal battery.

Cable and Adapters P/N: 1005278-01 5




Table 1. Receiver Cable and Adapters

AC/DC Desktop Wall Adapter
P/N: 1005518-01

Charges the receiver when connected to a
grounded outlet and the power charger
cable.
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Wall Adapter Folding Clip Kit
P/N: 1005519-01

Power adapters for use in different
countries including the UK, Australia, and
Europe.

NOTE: Wall adapter folding clip kit is not

required to be added on this adapter for use
in the USA. @

Drivers

32-bit or 64-bit Windows® driver is required. See “Before You Begin” on page 13.

Memory
The GCX2 is equipped with an internal, non-removable memory card that provides up to 8 GB of data storage.

As data is logged to the receiver’'s memory, the REC LED displays the memory capacity status. See “Recording
LED"” on page 9 for more information.

To access the raw data files in the receiver’s internal memory, see “"Record Data” on page 24.

Internal Battery

The GCX2 receiver was designed with one internal, non-removable battery. When fully charged, the battery
provide all day operation in any job configuration. The battery is easily charged using a USB cable. See “Internal
Battery” on page 11.

Long-Range Bluetooth Technology
The GCX2 receiver integrates Long-Range Bluetooth technology that enables multiple (up to 3) cable-free
connections to other GCX2 devices for Long-Range Bluetooth technology for base/rover RTK systems. You can

also connect the receiver to other Class 1- and Class 2-enabled Bluetooth devices (such as data collectors and
computers) using Bluetooth wireless technology concurrently with Long-Range Bluetooth connections.

Drivers P/N: 1005278-01 6




Sokkia’s Long-Range Bluetooth technology enables communication of RTCM3 differential corrections between
two GCX2 receivers over Bluetooth (up to 300 meters), eliminating the need for additional external radios for
corrections. See “"System Setup” on page 21.

@@ Distance for long-range largely depends upon environmental and field conditions.

USB Port Panel

The receiver is equipped with a USB 2.0 port for high-speed data transfer and communication between the
receiver and an external device, for charging the internal battery, and for powering the receiver with an external
power supply. See “Using Internal and External Power Sources” on page 11.

USB Port Panel

Mounting Socket

Figure 4: USB Port Panel

USB Port Panel P/N: 1005278-01
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Display Panel Operations

The LED display panel provides controls for receiver power and data recording. The LEDs display the status of the
satellite tracking, recording/memory capacity, Long-Range Bluetooth Technology® connections, and battery.

Status  Battery
(STAT) (BATT)

o

® <mm

Recording Bluetooth®
(REC) (BT)

Power
(PWR)

Figure 5: LED Display Panel
LED Icon Key

Table 2. LED Icon Key
Solid Blinking OFF

Display
L ') o=

Power Button

The green power button performs multiple functions. The duration in which the button is pressed and held
determines how the receiver will perform. While pressing the button, the LED panel indicates the selected
operation using particular LEDs.

Table 3. Power Button Functions

Function Press Button LED Description

Power ON 1+ seconds Power LED blinks green until the startup is complete and then the LED
turns OFF.

Power OFF 3-10 seconds All LEDs are OFF. Release the power button when Battery LED is solid.

Factory Reset 10-15 seconds All LEDs are OFF. Release the power button when Status LED is solid

Clear NVRAM red.

Erase All Files 15-20 seconds All LEDs are OFF. Release the power button when Recording LED is
solid red.
NOTE: 7his action is irreversible. If unsure about these actions,
continue to hold down the button until all LEDs return to normal.

Display Panel Operations P/N: 1005278-01 8



Table 3. Power Button Functions

Hardware More than 35-50 Shuts down power of all internal components of the receiver. This
Shutdown/Reset seconds function is only recommended when the receiver goes into
Exception mode. This operation does not affect internal memory or
receiver settings.

Open/Close Data File |3 times in a row within | The data file opens in Static mode.
2 seconds While the file is open, press the power button 2 times in a row within

1 second to switch back and forth between Static and Dynamic
modes.

To close a data file, press the power button 3 times in a row within 2
seconds.

Refer to the Recording LED description.
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Receiver Status LEDs

There are four status LEDs that display information about the battery life, tracked satellites, memory capacity,
and Bluetooth wireless connectivity. This section describes the color and behavior of each LED.

Tracking Status LED

The Tracking status LED displays how many satellites the receiver is tracking.
Table 4. Tracking Status LED Patterns

Display Description

> One blink per tracked GPS satellite.
GREEN

)
ORANGE
P ) One blink when there are no tracked satellites or solutions. It is OFF otherwise.

RED

Recording LED

The memory LED indicates if data is being written to memory and displays how much memory the receiver has
available for recording.

One blink per tracked GLONASS satellite.

Table 5. Recording LED Status

Display Function Description
GREEN: Greater than 50% File logging is in progress.
ORANGE: Greater than 10% Each blink indicates data is being written to memory.
RED: Less than 10% When the receiver is in Dynamic mode the LED blinks twice every second.

When the receiver is in Static mode the LED blinks once every second.

GREEN: Greater than 50% The file is closed. A solid light indicates no data is being recorded.
ORANGE: Greater than 10%
RED: Less than 10%

GREEN and RED: Alternating green and red LEDs indicate all files are being deleted.

Erase all memory

ORANGE and RED: Alternating red and yellow LEDs indicate the memory card is being initialized or
Formatting memory formatted.

BLACK: The LED is OFF.

IHHUCANE

Missing or faulty memory

Receiver Status LEDs P/N: 1005278-01 9




Communication LED

The Communication LED displays the status of the cellular and Bluetooth activity. The following tables describe
the communication activity for three use cases.

Bluetooth Status
Table 6. Bluetooth LED Patterns
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Display Description
BLUE: Bluetooth is ON. Waiting for a connection.
o>
BLUE: Single Bluetooth connection is established.
-
BLUE: LongLink connections are established. LED blinks for each connection every 5
L o seconds.
Bluetooth is OFF.
-
Battery LED

The Battery LED indicates the remaining charge of the internal battery. When an external power source is
utilized the LED turns green and begins to blink if the battery is charging.

Table 7. Battery LED Patterns

Display Description
RECEIVER IS ON/INTERNAL BATTERY IN USE
GREEN: The charge is greater than 50%.

ORANGE: The charge is greater than 15%.

RED: The charge is less than 15%.

RECEIVER IS ON/EXTERNAL POWER IN USE/PWR LED IS SOLID GREEN
GREEN: An external power source is in use. The internal battery is fully charged.

GREEN: The internal battery is at greater than 50% capacity. The battery is charging.

ORANGE: The internal battery is at greater than 15% capacity. The battery is
charging.

RED: The internal battery is at less than 15% capacity. The battery is charging.

RECEIVER IS OFF

RED: The receiver is connected to an external power source. The battery is fully
charged.

RED: The receiver is connected to an external power source. The battery is charging.

VO [0] 000 000
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Managing Power

Turning the Receiver ON/OFF

To turn on the receiver, press and hold the power button until the LEDs briefly flash. When the receiver is turned
ON, the receiver’s channels initialize and begin tracking all visible satellites at any time and location.

To turn OFF the receiver, press and hold the power button for more than three and less than 10 seconds (release
the power button when the BATT LED blinks solid red). This delay prevents the receiver from being turned OFF
by mistake.

The receiver will draw a small amount of power from the battery when it is turned off. If the receiver
</\/>@ is placed in storage for a long period, such as a few months, the battery may become fully
- . .
discharged. You will need to use an external power supply or recharge the battery before use.

Using Internal and External Power Sources

The receiver is powered by the internal battery or an external power source connected to the USB port. If an
external power source is connected, the receiver draws power from it in preference to the battery.

Using a standard USB cable, you can connect the receiver to an external power source with 4.5 to 5.5 VDC to
operate the receiver. See “Specifications” on page 32 .

@ Power input greater than 6 VDC could damage the receiver.

Internal Battery

The receiver first draws power from a connected external power source. When there is no valid external power
source connected or if the source has discharged lower than 4.5V, the receiver will draw its power from one high-
capacity internal battery (non-removable). Depending on the use case, the hours of operation provided by the
internal battery varies. See Table 8 on page 11.

The battery is shipped from the factory with a partial charge. For maximum operating time, fully
= charge the battery before using the receiver.

Table 8. Operation Hours

Use Description Approx. Hours of Operation

MAGNET Relay™ Base Base sending RTCM 3 differential corrections to MAGNET |12
Relay Service.

Long-Range Bluetooth Base sending RTCM 3 differential corrections to one Rover. | 12
Technology® RTK Base

Long-Range Bluetooth Rover receiving RTCM 3 differential corrections over Long- | 12
technology RTK or Range Bluetooth technology or from a Network site, and
Network RTK Rover corrected through Bluetooth to a data collector.

Static Survey Static setup logging raw GNSS data at 1 Hz. 12

@gg Approximate hours of operation listed are when operated at 20° C.

Managing Power P/N: 1005278-01 11



Charging the Battery

When the battery charge is low, the BAT LED changes from solid green to yellow and then red, depending on
the remaining charge. See “Battery LED” on page 10.

When the receiver is connected to an external power source, the battery charges whether the receiver is turned
ON or OFF.

To charge the battery:

lanmod 3uiSeuepy

1. Connect the supplied USB 2.0 cable to the receiver’s USB port.
2. Connect the USB cable to the USB port of the power adapter.

3. Plug the power adapter into an available outlet to fully charge the battery. The time to charge the battery
depends on whether the unit is ON or OFF, and if current is supplied from an external charger. The BAT

LED blinks as the battery charges.

The battery will stop charging when it is full.

/@ Use a grounded wall outlet or grounded surge protector while charging. The socket should be
S

located near the equipment and easily accessible.

Power Accessories

The USB 2.0 port of the GCX2 powers and charges the internal battery. The GCX2 is compatible with standard
USB power accessories used with consumer electronic devices. USB power accessories can be sourced locally
as long as USB power standards are met.

Insufficient Power

If the battery becomes fully discharged and an external power supply is not connected, the receiver will shut
down and automatically save recorded files. To avoid disruptions, check the BAT LED on the display panel for
the battery charge status. See “Battery LED"” on page 10 for more information.

If the receiver shuts down due to insufficient power, the receiver and all communication ports become
deactivated.

To restore power to your receiver and turn it back on, do one or all of the following:

* Recharge the battery.
* Make sure the USB cable is correctly connected to the receiver’s port.
¢ Connect the receiver to a different power source.

Power supplied to the receiver should match the specifications provided by Sokkia on the product.
Failure to comply with these specifications may damage the receiver.

Insufficient Power P/N: 1005278-01 12



Configuring the Receiver

The sections in this chapter describe receiver options, and how to load a new Option Authorization File (OAF),
update firmware, and perform a factory reset. Download the Sokkia Receiver Utility (SRU) software from the

Sokkia support website: http://sokkiasupport.com

For information about installing the software, see the Sokkia Receiver Utility (SRU) Reference Manual.
Before You Begin
A USB driver is required to connect the GCX2 to a computer. Determine whether your Windows operating systems

is 32-bit or 64-bit, and download the appropriate driver from the Sokkia support website:
http://sokkiasupport.com.

~ When the GCX2 is connected to a computer for the first time, a driver update will occur on the
= computer.

Viewing Receiver Information

In the Sokkia Receiver Utility (SRU), the Receiver Info window displays basic Receiver information, such as
hardware and firmware versions, RAM size, receiver ID, serial number, etc.

Open the Receiver Info Window

1. Connect the receiver to a computer and open SRU.
2. In SRU, connect to the receiver.
3. Click Device » Application Mode » Receiver Managing.
4. Click Device » Connect.
5. In the Connection Parameters window, select the correct USB port, and click Connect.
6. In the SRU main window, click the Information icon. The Receiver Info window appears.
[ (<6 Receiver nfo GREE
Mame Value
wliFModel GCNZ
@ Id Q01IMBSSVDOO
¥ Serial Number GCX2 PROTO-00048

Configuring the Receiver

¥ Board Version
@ GNSS Firmware Version
@ GNSS Hardware Version

@ Vendor Topcon

| w¥rReceiver Uptime 00:06:35
¥ CPU Fregq., MHz 235
IR AM Size, KB 16,384
=JFlash Memory Total, GB 7.46
=IIFlash Memory Available, GB 2.00
(=IFlash Memory Free, GB 2.00
SBattery A, v 10.20 (127%)
ﬁpower Supply, ¥ 0.00

| ﬁPower Board, V 10.20

B110_6
4.6 BLT Dec,09,2014 b3
205

Save to File

Figure 6: SRU - Receiver Info

P/N: 1005278-01
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Loading New Firmware

Receiver board firmware is released as a compressed file that you download and decompress. This file contains
the following files:

* ramimage.ldr — receiver board RAM file
* main.ldp - receiver board Flash file

Upload Firmware Files to the Receiver

1. Using a USB or Bluetooth connection, connect the receiver to a computer.

computer using a USB connection, you will need to install a USB driver. USB drivers and firmware are

' Upload firmware to the receiver using a Bluetooth or USB connection. To connect the receiver with a
available from the Sokkia support website: http://sokkiasupport.com

2. Click Device » Application Mode » Firmware Loading.
3. Click the Firmware Loading icon.

- Sokkia Receiver Utility 2| || x|
I Device View Help

Firmware

Loading
|i Firmware Loading | g

Figure 7: SRU - Firmware Loading

Loading New Firmware P/N: 1005278-01
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4. Click Device » Connect. The Connection Parameters window appears.

[F52Connection Parame... 7] -] 0] x|

Connect Using
|use v
Device Mame

GCX2 <001NBSSVDOO > B

Q)
©)
3
=
0q
c
=k
3
0q
-+
=y
)
A
¢}
0
o,
<
¢}
=

Figure 8: Connection Parameters Window

5. Select USB from the Connect Using drop-down list. Click Connect.
6. The Select Device window appears. Select Receiver in the Device Type field. Click Next.

-

Device Type
lHeca’va’ v]

Modem Firmware Format

Receiver Port
Intemal Modem

Serial C

Capture Method
Saft Break

Seral Port Settings

cBack || Net> | [ Cancel

Figure 9: SRU - Select Device
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7. The Information window appears. Click Next.

iill-im

Name Yalue

Device Type Receiver

Model GCX2

Id OOMZVMESEVE
Board Version B110_4

GMNSS Fimware Version 4.2 5PR Dec 27,2013
GMNSS Hardware Version 205
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Figure 10: Firmware Information

8. The Select Files screen appears. Click the Browse icon = next to the Image field, and select the
receiver board’s main file. Click Next to upload the firmware.

- —

 Select s N
Image:

| of

| <Back |[ Net> | [ Cancel

Figure 11: Select the Image File
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9. A confirmation window will appear when the firmware is loaded. Click OK to return to the Connection

Parameters window.

-

SRU

=X

'@ The firmware has successfully been updated.

OK

— Y ﬂ

Figure 12: SRU - Firmware Confirmation

10. Click Device » Connect.
11. From the Connection Parameters window, select USB Port and the port name, and click Connect.

12. In the SRU main window, click the information icon, and verify the firmware version uploaded appears in
the Receiver Info window.

Loading New Firmware

7

=% Receiver Info

= | B e |

MName

@ Model

@ d

@ Serial Number
@ Board Yersion
@@ Firmware Version

@ Yendor

w8 CPU Freg., MHz
HERAM Size, KB

e PP

@ Hardware Version

Value

Gex2
O01LZUNZOLE
GCx2
B1 4

4,0V Jun,29,2012 b&

205
Topcon

235
16,384

=JIFlash Memory Total, MB 3,839
=IFlash Memory Available, MB 2,046
=IFlash Memory Free, MB 2,042

Y.

-

m

-

= |

Save to File

Figure 13: SRU - Receiver Info Window
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Option Authorization Files

Sokkia issues an Option Authorization File (OAF) to enable the specific options purchased. Sokkia’s OAF system
enables you to customize and configure the receiver according to your particular needs, therefore purchasing
only the options you require.

The GCX2 receiver ships with standard GPS/GLONASS L1 1 Hz Static OAF option. Upgrade OAFs are available
for purchase. Contact your local dealer for more information on available receivers options for the GCX2. The
GCX2 receiver is capable of dual frequency static, LongRange, Network RTK, MAGNET Relay operation.

Contact your Sokkia dealer or a representative for a complete listing of available options and pricing information.

Checking the Receiver’s OAF
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View Receiver Options Using SRU

1. Connect the receiver to a computer and open SRU. See the Sokkia Receiver Utility (SRU) Reference
Manual.

2. In SRU, connect to the receiver.

3. From the main window, click the Options 3 icon.
The Receiver Options window appears. Click Upload OAF to upload new options.

- N
Receiver Options I. = | = ﬂ
Option Name Current | Purchased | Leased | Exp. Date | -

GPS Yes Yes Yes g/24/2011

Glonass fes Yes fes 9/24/2011 ‘E
L1 Yes Yes Yes 9/24/2011

L2 Yes MNa Yes 12/31/2011

Cinderella Yes Yes Yes 9/24/2011

Position Update Rate, Hz 100 20 100 12/31/2011

Raw Data Update Rate, Hz 100 20 100 12/31/2011

Code Differential Base fes Mo fes 9/24/2011

Code Differential Rover fes Mo fes 9/24/2011

RTK Base Yes No Yes 9/24/2011

RTK Rover, Hz 100 Disabled 100 9/24/2011

Memary, MB Mot supported 0 1,024 9/24/2011

Co-op Tracking Yes Mo Yes 9/24/2011

1-PPS Timing Signal Double Double Double 9/24/2011

Event Markers Double Mo Double 9/24/2011

In-Band Int. Rejection Mot supported Disabled Enabled Cutside USA 9/24/2011

Multipath Reduction Yes Yes Yes 9/24/2011 T

Refresh | @ Save to File |

Figure 14: Receiver Options
Loading an OAF

Sokkia dealers provide customers with OAF files. For OAF related questions, e-mail Sokkia at
options@sokkia.com. Include the receiver’s ID and serial number. See “Viewing Receiver Information” on
page 13.

Load a New OAF

1. Check the receiver’s OAF. See “Checking the Receiver’s OAF” on page 18.
2. From the bottom of the Receiver Options window, Click Upload OAF.

Option Authorization Files P/N: 1005278-01




3. Navigate to the location of the new OAF. Select the appropriate file and click Open..
[ & Open =5)
@Ovl .. » Computer » O5(C) » GCX2 - | g | | p |

Organize New folder = 0 @

Juo>

NS

. GMNSS Internet Radic & Mame o
| GSR2700 Cenfig Tool
L MAGMET

. Mission Planning Tool
. ModemTPS

. MMEA Reader

. NTRIP Client

L PC-CDU

. Pocket3D

1. Quality Center

_UNIVERSAL__tpo 3

(N

(o]
A 92y3 Su

0
0
o
<
®
€

.. RegPro
| RTKLib ~ | T b

File name: _UNIVERSAL_tpo A lﬂpti.ons Files (*.tpo) VI

q Open D[ Cancel ]

Figure 15: Load OAF

Sokkia’s SRU initially checks to see if the selected file is compatible with the currently connected
///g receiver. If you chose a file not intended for this receiver, the Upload OAF window displays an
error icon next to the Receiver ID and disables the Upload the File to the Receiver button.

4. To start loading the file, click Upload the File to the Receiver.

- My i [\
& Upload OAF (=] E &5 Upload OAF BE=

C:YGECX2Y UNIVERSAL . ipo = | Ci\Receiver OAF\ Universal. tpo
Property Value - Property Value
Flseriaiie A — Flserialve  SERIALNUMBER_1
[Flreceiverld _UNIVERSAL EReceiverlD  1037GYS30FK
ElModel KX-KXOO000-XX Universal Legacy 1= 2 01-10050020¢ MM 1
Flchecksum c19e = FElchedsum  B1gF
EDeaIer Topcon Positioning Systems, Inc, EDealer Topcon Positioning Systems, Inc.
EElTlall = = EEITIEI' . i e -
[FsubmitTime 2012-06-20 21:01:19 B [ElsubmitTime 2011-12-21 17:30:20
ECipher Digest ECipher Digest
FTI‘"nmmpnh‘: Tamenn | Imiveraal File | 3 Eﬂumments MMI test files
] 1 F

Upload the File to the Receiver ] IUpload the File to the Receiver

4 4
Figure 16: OAF Compatibility Check
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5. If an OAF file is uploaded to the receiver, SRU will offer to reset the receiver to put new authorization
options into operation. Click Yes.

F N

SRU —.

il The changes will take effect after reset. Reset the recerver?

ves || Ne
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Figure 17: Reset the Receiver

Resetting the Receiving (Clearing the NVRAM)

The receiver’s Non-Volatile Random Access Memory (NVRAM) holds data required for satellite tracking, such as
ephemeris data and receiver position. The NVRAM also keeps the current receiver’s settings, elevation masks,
recording interval, and information about the receiver’s internal file system. Clearing the receiver's NVRAM
resets the receiver and restores the factory default settings.

Although performing a factory reset of the receiver is not recommended as a common practice, there are times
when it can eliminate communication or tracking problems.

After performing a reset, the receiver requires about 15 minutes to collect new ephemerides and almanacs.

Resetting the receiver will not delete any files already recorded in the receiver’s memory, and the NVRAM keeps
information about the receiver file system.

Clear NVRAM Using SRU

1. Connect the receiver to a computer, and open SRU. See the Sokkia Receiver Utility (SRU) Reference
Manual.
2. In SRU, connect to the receiver.

From the main window, click the Tools icon .

aaaaa

4. The Tools window appears. Click Factory Reset, and then click Yes to continue.
al=e

Reset Receiver

Factory Reset

Reset Parameters

Reset RTK

Power Off

Sleep

Figure 18: Tools Dialog Box

Resetting the Receiving (Clearing the NVRAM) P/N: 1005278-01




System Setup

The GCX2 receiver’s advanced design eliminates the need for cables during operation, enabling for a simplified
setup with less parts to keep track of.

You can set up the GCX2 receiver in static or RTK configurations in the field and transmit RTK corrections from
the Base to the Rover receiver using Long-Range Bluetooth Technology®. You can use Bluetooth to connect to a
controller running SRU and MAGNET Field™ to configure the instrument and to collect and manage data.

Setting Up the Base Receiver

1. Mount the receiver on a tripod with a tribrach adapter.

Receiver

Tribrach Adapter

Tribrach

Tripod

Figure 19: Base Receiver

N

Position the base system over a known point.

3. Level the tripod and measure the height of the receiver from the ground using the tape measure. See
“Measuring Antenna Height” on page 23.

4. Press the power button to turn the receiver ON. The integrated wireless device in the receiver turns on when

the receiver is powered.

5. Connect the receiver to the Bluetooth-enabled data collector, running Sokkia Field software, to configure and
start the base GCX2 receiver.

6. View the LED display panel for the receiver’s current status. See “Display Panel Operations” on page 8.
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Setting Up the Rover Receiver

1. Mount the receiver on the rover pole.

Receiver

Range Pole

Controller
Bracket

Data
Controller

Figure 20: RTK Rover

2. Attach a Sokkia controller to the pole using a mounting bracket.

3. If you are not using a fixed height rover pole, measure the height of the receiver from the ground. See
“Measuring Antenna Height” on page 23.

4. Press the power button to turn the receiver ON. The integrated wireless device in the receiver turns on
when the receiver is powered.

5. Connect the receiver to the Bluetooth-enabled data collector that is running Sokkia Field software, to
configure the GCX2 as a rover receiver.

6. View the LED display panel for the receiver’s current status. See “Display Panel Operations” on page 8.

Setting Up the Rover Receiver P/N: 1005278-01
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Measuring Antenna Height

The receiver calculates the coordinates of the antenna’s phase center. To determine the coordinates of the
station marker, specify the following:

* measured height (H) of the bottom of the receiver above the station marker (refer figure 21)
* model of the receiver (GCX2) used

Any necessary antenna phase center adjustments, based on the antenna model, is automatically applied. This
adjustment, when combined with accurately measured height and measurement methods, enables correctly
computed reference marker coordinates.

Obtain Accurate Antenna Height

1. Measure the height of the bottom of the receiver or Antenna Reference Point (ARP) above the control
point or marker.

Topcon software only requires input of measured height (H) to compute coordinates of Antenna
//ZS phase center of the receiver. For precise antenna height, it is recommended to use vertical
measurement method.

-

Receiver ry Receiver

v
A' Station Marker

Figure 21: Obtaining Antenna Height
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This chapter provides general information about recording data, downloading it, and removing files to free up
internal memory.

Set Recording Parameters

The Sokkia Receiver Utility (SRU) software enables you to set logging parameters, such as logging rate and types
of messages, in which to record data. See the SRU Reference Manua/or SRU Help for more information.

The GCX2 is compatible with any Sokkia field software for configuration and recording raw data.

Log Rates

The receiver provides up to 2 GB of file space on the internal (non-removable) memory card. The amount of
memory used to log data depends on the logging rate. See SRU Reference Manual or SRU Help.

Record Data

Log raw GNSS data to the receiver’s internal memory and use the Sokkia Receiver Utility (SRU) or MAGNET
Office™ software to download the files to a computer.

Start/Stop Recording Using LED Display Panel or SRU

1. Press the power button to turn the receiver ON.
2. Wait for the STAT LED to indicate satellites are being tracked.

The STAT LED blinks green for GPS satellites and amber for GLONASS satellites. A short red blink
= indicates the receiver has not solved a position. Five or more satellites provide optimal positioning.

3. Press the POWER button three times within two seconds to begin recording. To begin recording data, in SRU
select File Explorer » Logs » Start.

4. Ensure the REC light is blinking green. This indicates that a file has opened and data collection has started.
The REC LED blinks each time data is saved to the internal memory.

5. When finished recording, press the power button three times within two seconds. Ensure the REC LED is
dark. To end data recording, in SRU select File Explorer » Logs » Stop.

6. To turn the receiver OFF, press and hold the power button for 3 to 10 seconds until all LEDs turn dark and
the BAT LED is solid red.

<//\>€S You can also log data using MAGNET Field software.
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File Management

Raw data is recorded as time-tagged measurements in a single raw data file. Each file is recorded to the
receiver’s internal memory, and automatically given a name and a *.tps file extension. You can then transfer a
file of collected data to a computer with file managing software, such as the Sokkia Receiver Utility (SRU). This
program enables you to use an automatic naming feature, enter file names, and delete files as necessary.

See the SRU Reference Manual or SRU Help.
Download and Delete Files

After completing a survey, download data files to a computer or a controller for storage, post-processing, or
backup. The receiver’s internal memory holds a finite amount of files, so you will want to delete files to restore
memory capacity.

When the internal memory is full, the receiver stops logging data, and the REC LED turns dark/off, indicating
an error condition. Existing data is not overwritten, unless AFRM mode is enabled.

There are two options for deleting raw data files from the receiver:
¢ Delete all of the files using the LED display panel (i.e. hold the power button for 15 to 20 seconds).

@ This erases all of the files in the receivers internal memory.

* Use a USB or Bluetooth connection to download the files to a computer. In SRU, you can select the files you
want to delete from the receiver. See the SRU Reference Manua/ or SRU Help.

Once a connection is established, you can download all or some files to a computer or controller and then use
the File Explorer feature in Sokkia Receiver Utility (SRU) to manage the raw data files.

For more information about using SRU to download or delete files, see the Sokkia Receiver Utility (SRU)
Reference Manual or SRU Help.

File Management P/N: 1005278-01



Troubleshooting

This chapter will help you diagnose and solve some common problems that may occur with the receiver.

' Do not attempt to repair equipment yourself. Doing so will void the warranty and may damage the
hardware.

Check This First

Before contacting your local dealer or Sokkia Technical Support, check the following:

* Check all external receiver connections carefully to ensure correct and secure connections. Double check for
worn or defective cables.

* Check the receiver’s internal battery for a full charge.

* Check the power source for incorrectly connected cables, and ensure the power source is valid. See
“Specifications” on page 32 for external power requirements.

* Check the software. Ensure the most current software version is downloaded onto the computer and the most
current firmware is loaded into the receiver. For the latest updates, check the Sokkia website:
http://sokkiasupport.com

* Check Sokkia Technical Support: http://sokkiasupport.com for the latest updates.
Then, try the following:

* Power cycle OFF/ON the receiver by pressing the Power button or by using SRU (Tools » Reset receiver).

* Restore default settings by pressing the Power button for 10 to 15 seconds or using SRU
(Tools » Factory Reset). This restores the receiver’s parameters to the factory default settings and erases the
almanac and ephemeris files. This action does not delete data files from the receiver memory.

* Erase all files by pressing the Power button for 15 to 20 seconds or by using File Explorer » Delete All Files
in SRU. This will delete all files stored in the receiver’s non-removable memory card.

If the problem persists, see the following sections for other solutions.
Powering Problems

The following are some of the most commonly encountered power problems.

Receiver Does Not Power Up

Cause Solution

The battery may be discharged. ¢ Charge the battery overnight.
See “Charging the Battery” on page 12

If an external power source is being used, the | e Ensure the cable is securely connected and undamaged.
cable may be disconnected or damaged.

The receiver may have a defective charger or « If, after changing the battery or connecting an external
defective battery. power source, the receiver still does not power up,
contact your local dealer or Sokkia Technical Support for
advice.

Troubleshooting P/N: 1005278-01 26
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Receiver Problems
The following are some of the most commonly encountered receiver problems.
No Connection to Computer or External Controller

Cable Specific Problems
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Cause Solution
The cable is not properly plugged in. ¢ Unplug the cable, then securely and properly reconnect it
to the receiver.
The cable is damaged. ¢ Use an undamaged cable. Contact a dealer to replace the
cable.
The USB driver is not installed. o If a USB cable connection is being used, ensure the USB

driver is installed on the computer.

The driver may be downloaded from the Sokkia website:
http://sokkiasupport.com.

The cable is damaged. ¢ Use an undamaged cable. Contact a dealer to replace the
cable.

Generic Problems

Cause Solution

The receiver port used for connection is not in | e Connect the receiver to a computer and open SRU
Command mode. See “Connection” in the Sokkia Receiver Utility (SRU)
Reference Manual.

¢ Click Receiver Settings » Ports.

¢ Change the Input mode for the port used for connection
to cmd.

The receiver goes into Exception mode ¢ Hardware Shutdown/Reset by pressing power button for
and/or is non-responsive or frozen and can not more than 35-50 seconds.
be recovered by reloading firmware.

This shuts down power of all internal components of the
receiver. This operation does not affect internal memory
or receiver settings.

No Long Term Lock on Satellites

Cause Solution
The corresponding receiver options may be ¢ Order a new OAF with the desired options activated to
disabled or expired (L1/L2, GPS/GLONASS must enable or extend validity of the corresponding receiver
be on to track satellites). options. Contact a dealer or visit the Sokkia website for
details.

¢ For a detailed description of options, see “Receiver
Managing” chapter of the Sokkia Receiver Utility (SRU)
Reference Manual

Receiver Problems P/N: 1005278-01
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Too Few Satellites Tracked

Cause Solution

The survey is conducted near obstructions (tree |e Ensure the Multipath Reduction boxes have been
canopy, tall buildings). enabled.

a. Connect the receiver to a computer and open
SRU
(see “Connection” in the Sokkia Receiver
Utility (SRU) Reference Manual).

b. In SRU, connect to the receiver.
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c.  On the SRU main window, choose Receiver
Settings » Tracking » Adv tab. Ensure the
C/A code multipath reduction check box is
selected.

¢ Move to an area free of obstructions, if applicable.

No Code Differential and/or RTK Solutions Obtained

Cause Solution

Incorrect Base coordinates entered. » Specify the correct coordinates for the Base station using
SRU or another suitable field data collection software.

There could be some obstruction to the Long- | e Clear all possible obstructions or relocate the Base so

Range Bluetooth Technology® connection. there is a “line-of-sight” path to the Rover.

The corresponding receiver options may be ¢ Order a new OAF with the required options activated to

disabled or expired. enable or extend validity of the corresponding receiver
options.

o Refer to the Sokkia Receiver Utility (SRU) Reference
Manual for a detailed description of options.

There are not enough common satellites. In ¢ Check the elevation masks of the Rover and Base
order to obtain a fixed solution, the Base and receivers; they should be the same. To do this, on the
Rover should track at least five common SRU main window, choose Receiver

satellites. Settings » Tracking » Obs.

o Verify there is a clear view of the sky to allow sufficient
satellite tracking.

A discrepancy exists between the differential ¢ Ensure the Base and Rover receivers use the same

standards used at the Base and Rover receivers. corrections input/output format:

a. Connect the receiver to a computer and open
SRU
See “Connection” in the Sokkia Receiver
Utility (SRU) Reference Manual.

b. In SRU, connect to the receiver.

On the SRU main window, choose Receiver
Settings » Ports.
d. Double-click on the port to be configured and

Ensure the input mode of the Rover matches
the format of the Base output mode (i.e.

RTCM3).
Poor satellite geometry (PDOP/GDOP values are |e Conduct the survey where satellite visibility is better (low
too high). PDOP value).
¢ Ensure the elevation mask is less than 15 degrees.
The elevation mask is above 15 degrees. ¢ Lower the elevation mask. To do this, on the SRU main

window, choose Receiver Settings » Tracking » Obs.

o Verify there is a clear view of the sky to allow sufficient
satellite tracking.
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Cause Solution

There may be a source of radio interference that | e Change the RF channel (if possible).

disrupts radio communications.  Removing the source of the jamming signal or relocate
the radio antennas (if possible).

Receiver Does Not Log Data
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Cause Solution

The receiver’s memory is disabled or expired. ¢ The receiver’s memory is disabled or expired.

¢ Ensure the memory option is enabled. For details, see
the Sokkia Receiver Utility (SRU) Reference Manual.

¢ The receiver’s internal memory card does not have free
space.

¢ Download and/or delete data files to free up space for
new files. See “Download and Delete Files” on page 25.

Bluetooth Problems

The following are some of the most commonly encountered error messages and other problems.

SRU Error Message: Can’t Find Receiver

Cause Solution

The receiver is turned OFF. ¢ Ensure the receiver has power and is turned on.

Bluetooth is not turned on; the BT LED is OFF. | e Reset the receiver to the factory default settings by
pressing the Power button for 10 to 15 seconds.

There is interference. ¢ Move the receiver, controller, or computer to an
unobstructed location.

The receiver is too far away. ¢ Move the devices closer together.

The receiver is already connected via Bluetooth |e Disconnect the receiver from the other controller or

to another device. computer

The receiver port used for connection is notin | e Connect the receiver to a computer and open SRU

Command mode. See “Connection” in the Sokkia Receiver Utility (SRU)
Reference Manual.

¢ Click Configuration » Receiver » Ports.

¢ Change the Input Mode for the Bluetooth or USB port
used for connection to cmd

Long-Range Bluetooth technology connections will not interfere with Bluetooth connections to
computers or controllers.

Use SRU to double check the settings for the connection port.
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No Available Devices Discovered 6_‘|
c

Cause Solution E

The receiver is not receiving power. ¢ Check that the receiver is getting power and is turned 3

ON. -y

¢ Check that the power cable is correctly attached to the 8

port. =

3

(0]

¢ Unplug the cable, then securely and properly reconnect it
to the receiver.

o If the power cable is damaged, contact a Dealer to
purchase a new cable.

Receiver Bluetooth Icon Visible, but Cannot Establish Connection

Cause Solution

Device security settings probably differ. ¢ Ensure the Bluetooth enabled devices use the same
security settings.

Bluetooth module settings may have changed. |e If the settings are changed for the Bluetooth module,
remove it from the list of discovered Bluetooth devices
using the Bluetooth manager program (supplied with the
device used to manage the receiver).

¢ Repeat the search.

Long-Range Problems
The following are some of the most commonly encountered problems.

Long-Range Cannot Discover Base Receiver

Cause Solution

The Base is out of range. Ensure the Base receiver is within 300 meters of the Rover.
Distance for Long-range largely depends upon environmental
and field conditions.

The Base is not responding. ¢ Ensure the Base is turned ON.

¢ Ensure Bluetooth is turned ON for the Base and Rover
(i.e. the Bluetooth LEDs are blue ON both receivers).

e Ensure there are no obstructions or interference.

Cannot Establish Bluetooth Connection

Cause Solution

A Long-Range Bluetooth connection is not ¢ Ensure there are no obstructions or interference.
available at the Base. (for example, three
connections are already established.)
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SRU Problems

The following is the most commonly encountered SRU problem.

SRU Cannot Connect to Receiver

Cause Solution
The receiver is turned OFF. ¢ Ensure the receiver has power and is turned ON.
If using a USB cable, the cable’s connectors are | e Unplug the cable, then securely and properly reconnect it
improperly attached. to the receiver.
If using a USB cable, the cable is damaged. ¢ Use an undamaged cable.
¢ Contact a dealer to purchase a new cable.
If using Bluetooth wireless technology, the ¢ Use a computer or receiver that has Bluetooth wireless
incorrect port is selected. technology enabled/installed.
¢ Ensure the computer and receiver use the correct ports
for communication. For the GCX2 receiver, this is
Bluetooth or USB.

Cleaning and Storing the Receiver

* Use a clean cloth moistened with neutral detergent or water.
* Never use an abrasive cleaner, ether, thinner benzene, or other solvents.

¢ Always ensure the receiver is completely dry before storing it. Dry any moisture with a soft, clean cloth.

Getting Customer Support

If the troubleshooting hints and tips in this operator’s manual fail to remedy the problem, contact Sokkia
Customer Representative. For contact information, see “Getting Technical Support” on page 3.

SRU Problems P/N: 1005278-01
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Specifications

The GCX2 is a GNSS receiver featuring 226 channels and Long-Range Bluetooth Technology® for small job site
operations and cable-free network solutions.

General Details

Table 9 lists the GCX2's general specifications.

Table 9. General GCX2 Specifications

Physical
Enclosure Aluminum alloy with Lexan cap
Color Sokkia Gray and Blue (base)

Dimensions (mm)

47 (w) x 47 (d) x 184.5 (h) mm

Weight (g)
including battery

Up to 375g, depending on the configuration

Status MINTER (4 LEDs + 1 power button)
display/panel
USB/Power USB Mini B 2.0 (for communications and power)

Bluetooth antenna

Fully integrated, high-sensitivity

Tracking

Number of
Channels

226 channels with optimized satellite tracking technology

NOTE: Includes two dedicated channels for L-Band signal tracking. The GCX2 receiver does not
support L-Band signal tracking.

Tracked Signals

GPS: L1 C/A, L1C, L2P, L2C code and carrier
GLONASS: L1 C/A, L1P, L2 C/A, L2P code and carrier
SBAS: L1 C/A, WAAS/MSAS/EGNOS

QZSS: L1 C/A, L1C, L2C

GAGAN: L1

Multipath
reduction

Yes, code and carrier

PLL/DLL setting

Adjustable bandwidth and order

Smoothing
interval

Pseudorange smoothing: Adjustable

Data Output

RTK Corrections

TPS, RTCM SC104 v 2.x, 3.x; CMR/CMR+

ASCII Output

NMEA 0183 version 2.x and 3.0

RTK position data | 10 Hz
rate

Measurement 10 Hz
data rate

Real time data
output

TPS; RTCM SC104 v 2.x and 3.x; CMR/CMR+

NOTE: CMR/CMR+ is a third-party proprietary format. Use of this format is not recommended and
performance is not guaranteed. Use of industry standard RTCM 3.x is always recommended for
optimal performance.

Specifications
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Table 9. General GCX2 Specifications

Data and Memory

Removable media

None

Internal memory

Internal up to 2GB

Message storage
rate (max.)

10 Hz; up to 3,000 files

Environment

Operating Battery Charging: -0° C to +45° C

temperature Battery Operation: -20° C to +63° C (with internal batteries)
Cable Operation: -40° C to +63° C (with external power)

Storage -40°C to +85°C

temperature

Humidity 100%, condensing

Waterproof rating | IPX7 (1 meter submersion)

Dust rating IP6X (Fully dust proof)

Random vibration

MIL-STD 810G, Method 514.6, Broad band noise (random vibration), along each of 3 axes,
Category 4, table 514.6C-1V

Shock MIL-STD 810G Method 516.6. Table 516.6-1 Alternate Test Method of Classical Pulse; 40g,
11ms duration.

Topple 2.0m pole drop; 1.0m handling drop

Technology

Long-Range Bluetooth® technology
Optimized satellite tracking technology
Precision Orbital Satellite Technology (POST) integrated antenna

Power

Internal Battery
non-removable

3.7 V, 5800 mAh

Battery charging
time

<5 hours if unit is OFF and using external 2A power source.

NOTE: Charging time depends on external charger and cable used.

Battery charging
method

Connect to a USB power adapter to charge the internal battery. Available run charge when
connected to an external power adapter. Charging of internal battery when power input is
greater than 4.5 V.

Operating time

>12 hrs

General Details
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Table 9. General GCX2 Specifications

External power
input

4.5 to 5.5 VDC USB standard, normal ambient conditions

NOTE: 4.5 to 5.5 VDC is the operating range of the external power source when the receiver is on. To
turn the receiver on, the power input must be between 4.5 and 5.5 VDC. To charge the internal battery,
the external power input must be greater than 4.5 VDC.

Power
consumption

1.5 W (RTK Rover with Long-Range Bluetooth technology, using the internal battery at
20° C)

External power
supply adapter
rating

Input: 100-240 VAC, 50-60 Hz, 0.8 A
Output: +5 VDC/2 A

Communication

uUsB 1 port; USB Mini B 2.0 Full Speed (client)

Long-Range 300m range with up to 3 simultaneous rovers.

Bluetooth Typical long-range distance with clear line of sight. Distance for long-range largely depends
technology upon environmental and field conditions.

Bluetooth v2.1 + EDR

Survey Accuracy

Static, fast-static L1 +L2:

(post-processed)

H: 3 mm + 0.5 ppm
V: 5 mm + 0.5 ppm

Kinematic, RTK

L1 +L2:
H: 10 mm + 1.0 ppm
V: 15 mm + 1.0 ppm

DGPS H: 0.4m V: 0.6m
SBAS H: ImV: 1.5m
Maximum data 10 Hz
rate
Cold start <40 sec.
Warm start <20 sec.
Reacquisition

<1 sec.
RTK Time-to- 2-8 seconds

First-Fix (TTFF)

General Details
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Safety Warnings

General Warnings

To comply with RF exposure requirements, maintain at least 25cm between the user and the receiver
when operating Long-Range Bluetooth Technology® technology.

distances, angles and depths, and recording such measurements). This product should never be used:
¢ Without the user thoroughly understanding this manual.

¢ After disabling safety systems or altering the product.
* With unauthorized accessories.

¢ Without proper safeguards at the survey site.

¢ Contrary to applicable laws, rules, and regulations.

' Sokkia receivers are designed for survey and survey related uses (that is, surveying coordinates,

Sokkia receivers should never be used in dangerous environments. Use in rain or snow for a limited
period is permitted.

Battery Warnings

Tampering with the battery by end users or non-factory authorized technicians will void the battery’s
warranty.
' ® Do not charge in conditions different than specified.
® Do not use other than the specified battery charger.
® Do not short circuit.
°

Do not crush or modify.

Receiver Warnings

receiver’s warranty:
® Do not attempt to open the receiver and modify any of its internal components.
® Do not charge in conditions different than specified.
® Do not short circuit.

' Tampering with the receiver by the end users or non-factory authorized technicians will void the

Usage Warnings

otherwise treated without care, erroneous measurements may occur.
The owner should periodically test this product to ensure it provides accurate measurements.
Inform Sokkia immediately if this product does not function properly.

' If this product has been dropped, altered, transported or shipped without proper packaging, or
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Regulatory

The following sections provide information on this product’s compliance with government regulations for use.

FCC Compliance

This equipment complies with FCC radiation exposure limits set forth for uncontrolled equipment and meets the
FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65. This equipment has very low levels of
RF energy that it deemed to comply without maximum permissive exposure evaluation (MPE). But it is desirable
that it should be installed and operated with at least 20cm and more between the radiator and person’s body
(excluding extremities: hands, wrists, feet and ankles).

This equipment has been tested and found to comply with the limits for a Class B digital device pursuant to part
15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference when
the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful
interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful
interference in which case the user will be required to correct the interference at his own expense.

If this equipment does cause interference to radio or television equipment reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Move the equipment away from the receiver.

* Plug the equipment into an outlet on a circuit different from that to which the receiver is powered.

* Consult the dealer or an experienced radio/television technician for additional suggestions

Any changes or modifications to the equipment not expressly approved by the party responsible for
compliance could void your authority to operate such equipment.

Industry Canada Compliance

This class B digital apparatus complies with Canadian CAN ICES-3 (B)/NMB-3(B).
Cet appareil numérigue de /a classe B est conforme a la norme NMB-003 du Canada.

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the following
two conditions: (1) this device may not cause interference, and (2) this device must accept any interference,
including interference that may cause undesired operation of the device.

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence.
L'exploitation est autorisée aux deux conditions suivantes : (1) 'appareil ne doit pas produire de brouillage, et (2)
I'utilisateur de I'appareil doit accepter tout brouilage radioélectrique subi, méme si le brouillage est susceptible
d’en compromettre le fonctionnement.
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Community of Europe Compliance

The product described in this manual is in compliance with the R&TTE and EMC directives from the European
Community.

A1ojen3ay

European Community Declaration of Conformity with R&TTE Directive
1999/5/EC

The following standards were applied: (R&TTE Directive 1999/5/EEC)

e EN 301 489-1V1.9.2

* EN 301489-3V1.6.1

* EN 301 489-17 V2.2.1

e EN300328V1.8.1

* EN 300 440-2 V1.4.1

e EN 55022:210/AC:2011

* EN 55024:2010

* EN 60950-1:2006+A1:2010+AC:2011+A2:2013
The following CE mark is affixed to the device:

3

This is a Class A product. In a domestic environment this product may cause radio interference in
which case the user may be required to take adequate measures.
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Declaration of Conformity (R&TTE Directive 1999/5/EC) o
0Q
c
o))
o
esky [Czech] (Sokkia) timto prohlasuje, ze tento (GCX2) je ve shod se zakladnimi pozadavky a dalSimi Q
pislusnymi ustanovenimi smrnice 1999/5/ES.
Dansk [Danish] Undertegnede (Sokkia) erklzerer herved, at fglgende udstyr (GCX2) overholder de

vaesentlige krav og gvrige relevante krav i direktiv 1999/5/EF.

Deutsch [German] Hiermit erklart (Sokkia) dass sich das Gerdt (GCX2) in Ubereinstimmung mit den
grundlegenden Anforderungen und den {ibrigen einschldgigen Bestimmungen der
Richtlinie 1999/5/EG befindet.

Eesti [Estonian] Kaesolevaga kinnitab (Sokkia) seadme (GCX2) vastavust direktiivi 1999/5/EU
pohinduetele ja nimetatud direktiivist tulenevatele teistele asjakohastele satetele.

English Hereby, (Sokkia) declares that this (GCX2) is in compliance with the essential
requirements and other relevant provisions of Directive 1999/5/EC.

Espafol [Spanish] Por medio de la presente (Sokkia) declara que el (GCX2) cumple con los requisitos
esenciales y cualesquiera otras disposiciones aplicables o exigibles de la Directiva
1999/5/CE.

[Greek]

ME THN MNAPOYZA (Topcon Positioning Systems,
Inc.) AHAQNEIOTI (GRX1) ZYMMOPDQNETAI
MPOZ TIZ OYZIQAEIZ ANAITHZEIZ KAI TIZ ACIMNEZ
ZXETIKEZ AIATAZEIZ THZ OAHIIAZ 1999/5/EK.

Francais [French] Par la présente (Sokkia) déclare que l'appareil (GCX2) est conforme aux exigences
essentielles et aux autres dispositions pertinentes de la directive 1999/5/CE.

Italiano [Italian] Con la presente (Sokkia) dichiara che questo (GCX2) & conforme ai requisiti essenziali ed
alle altre disposizioni pertinenti stabilite dalla direttiva 1999/5/CE.

Latviski [Latvian] Ar So (Sokkia) deklar, ka (GCX2) atbilst Direktvas 1999/5/EK btiskajm prasbm un citiem ar

to saisttajiem noteikumiem.

Lietuvi [Lithuanian] Siuo (Sokkia) deklaruoja, kad $is (GCX2) atitinka esminius reikalavimus ir kitas 1999/5/EB
Direktyvos nuostatas.

Nederlands [Dutch] Hierbij verklaart (Sokkia) dat het toestel (GCX2) in overeenstemming is met de essenti€le
eisen en de andere relevante bepalingen van richtlijn 1999/5/EG.

Malti [Maltese] Hawnhekk, (Sokkia) , jiddikjara li dan (GCX2) jikkonforma mal-tiijiet essenzjali u ma
provvedimenti orajn relevanti li hemm fid-Dirrettiva 1999/5/EC.

Magyar [Hungarian] | Alulirott, (Sokkia) nyilatkozom, hogy a (GCX2) medfelel a vonatkozo alapveto
kovetelményeknek és az 1999/5/EC irdnyelv egyéb elGirasainak.

Polski [Polish] Niniejszym, (Sokkia) , deklaruj, e (GCX2) spenia wymagania zasadnicze oraz stosowne
postanowienia zawarte Dyrektywie 1999/5/EC.

Portugués (Sokkia) declara que este (GCX2) esta conforme com os requisitos essenciais e outras

[Portugues] disposicoes da Directiva 1999/5/CE.

Slovensko [Slovenian] | (Sokkia) izjavlja, da je ta (GCX2) v skladu z bistvenimi zahtevami in ostalimi relevantnimi
doloili direktive 1999/5/ES.

Slovensy [Slovak] (Sokkia) tymto vyhlasuje, ze (GCX2) spa zakladne poziadavky a vSetky prislusne
ustanovenia Smernice 1999/5/ES.

Suomi [Finnish] (Sokkia) vakuuttaa taten etta (GCX2) tyyppinen laite on direktiivin 1999/5/EY oleellisten
vaatimusten ja sita koskevien direktiivin muiden ehtojen mukainen.

Svenska [Swedish] Harmed intygar (Sokkia) att denna (GCX2) star I Gverensstammelse med de vasentliga
egenskapskrav och 6vriga relevanta bestdmmelser som framgdr av direktiv 1999/5/EG.
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WEEE Directive

Following information is for EU-member states only:

The use of the symbol below indicates that this product may not be treated as household waste. By ensuring
this product is disposed of correctly, to help prevent potential negative consequences for the environment and
human health, which could otherwise be caused by inappropriate waste handling of this product. For more
detailed information about the take-back and recycling of this product, please contact a supplier where you
purchased the product or consult.

A1ojen3ay

Bluetooth Transmission Statements/Compliance

This Bluetooth device is compliant to the following profiles of the core spec version 2.1/2.1+EDR:

* Baseband

e HCI

¢ Link Manager

* Radio
The radio has been tested using the maximum antenna gain of 2.3 dBi and the Bluetooth qualification is valid
for any antenna with the same or less gain.

Korean KC-RF Compliance

Trade Name or Application Name: Topcon Positioning Systems, Inc.
Equipment Name: GNSS Receiver

Basic Model Name: GCX2

Ceretificate Number: MSIP-RMM-T8S-126650

Manufacturer/Country of Origin: Topcon Positioning Systems, Inc./U.S.A.
Approval Issue Date: 2015-01-05

Korean KC-EMC Class B Statement
Ol 212l JId2 B2) MUNIIEEIIJIZM =2 JIFUHA Aot A
SE XNGUHM AAEE = USLICH.

Japan Radio Law and Telecommunications Business Law Compliance

4

nio

SHOZ olH ,

Bluetooth Module Compliance

The integrated Bluetooth module WT-41 reference application described on page 72 (General Details -
Communication) complies in accordance with the provisions of Article 38-24 paragraph 1 of Japan Radio Law.
The certificate granted in accordance with Japan Radio Law has the following:

Certification Number: ATCB013105
Identifier: R 209-J00047
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Warranty

Sokkia! positioning equipment are guaranteed against defective material and workmanship under normal use and
application consistent with this Manual. The equipment is guaranteed for the period indicated, on the warranty
card accompanying the product, starting from the date that the product is sold to the original purchaser by
Sokkia‘s Authorized Dealers.

During the warranty period, Sokkia will, at its option, repair or replace this product at no additional charge. Repair
parts and replacement products will be furnished on an exchange basis and will be either reconditioned or new.
This limited warranty does not include service to repair damage to the product resulting from an accident, disaster,
misuses, abuse or modification of the product.

Warranty service may be obtained from an authorized Sokkia warranty service dealer. If this product is delivered
by mail, purchaser agrees to insure the product or assume the risk of loss or damage in transit, to prepay shipping
charges to the warranty service location and to use the original shipping container or equivalent. A letter should
accompany the package furnishing a description of the problem and/or defect.

The purchaser’s sole remedy shall be replacement as provided above. In no event shall Sokkia be liable for any
damages or other claim including any claim for lost profits, lost savings or other incidental or consequential
damages arising out of the use of, or inability to use, the product.

1. The warranty against defects in a Sokkia battery, charger, or cable is 90 days.
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SOKKIA

Sokkia® is a registered trademark of the Topcon group of companies
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